Radio Control Model Airplane Flying: Basic Thru Intermediate Skill Levels

By George Krueger, Coachella Valley Radio Control Club

George.kru@gmail.com

Last Revised: 12/8/2017

Contents:

1. Real Flight Simulator Setup for Training
2. Basic Principles
3. Practice Flying
4. Basic Aerobatics
Training Setup, Real Flight 6.5 RC Airplane Simulator

Here are some notes, hopefully helpful, about setting up a high-wing trainer RC airplane for practice flying on the simulator. It presumes a modest level of skill gained from some initial actual experience with an Apprentice or similar RC airplane at the flying field. Let’s presume you are a new user of the simulator and don’t yet know all the features. This nominal setup will get you going for some practice flying at a field with a paved runway. You can change some of the parameters later to suit your needs or preferences.

For a good introduction to RC flying watch the You Tube video “How to fly a 4 channel RC airplane” by VoroRC.

A. Terminology: I will use the symbol > to indicate a left-click of the computer mouse on the selected menu or drop-down menu item. Most of the main menu items are shown at the top of the simulator screen, click on them to get a further drop-down menu.

B. Aircraft: BLT Park Flyer (get this with these commands: Aircraft > Select Aircraft > BLT Park Flyer > OK). The BLT is a simple airplane that flies slowly and will give you early success. The PT40 can also be used but is more difficult to fly.

C. Field: Evergreen Airport (Environment > Select Airport > Evergreen Airport. Note: this might already be the default airport on your sim).

D. Calibrate Controller (this MUST be done on every “cold start” of your simulator, or your airplane will not respond properly to the transmitter): (Controller > Controller Calibration > follow procedure).

E. View: keep field in view when you’re reasonably low (View > Zoom Type > Keep Field in View).

F. Binoculars: this small window gives a close-up view of the airplane when you’re far away (Gadgets > Binocular). Note that this view is from the perspective of the pilot station, not from a chase plane or some other point closer to the model. Also note that you can move this small window anywhere on the main screen by clicking and dragging it. An example of a useful view setup is shown below:
G. Useful Keyboard Commands: K, kills the motor. P, establishes a new “Reset” position (for example, pushing P when the airplane is on the downwind leg of the landing pattern means that the airplane will resume this position every time the transmitter Reset button is pushed. Very useful for training! Push P at the beginning of any maneuver you wish to practice repeatedly, then Reset takes you there right away.

H. Wind, Sun Angle, Etc.: leave these alone for now (wind will nominally be at zero. You can add wind later).

I. Airplane Trim: the program usually sets nominal pitch and roll trim so the airplane climbs slightly with wings level at high power with neutral sticks. If not, adjust using the little trim levers next to the sticks on the transmitter. For example, pulling aft on the elevator trim lever induces “up” elevator trim as you continue to hold the lever aft, more if you hold the lever longer. Do this in small increments as you watch the flight path of the model.

J. Finally, you’re ready to fly! Fortunately, your simulator will reset to these parameters each time you turn it on. But remember, every “cold start” (say after a simulator exit) requires a controller recalibration.

K. As you progress you can try different airplanes such at the PT40 trainer or the Nexstar. For a different airport, try Carl Henson Field.
Let's first review some basics, then we'll fly!

1. Use proper terminology to describe the airport traffic positions and where you are: Taxi for Takeoff, Takeoff, Upwind, Crosswind, Downwind, Base, Final, Short Final, Touchdown.

2. Airplanes in flight have variations in speed and they move about their pitch (controlled by elevator), roll (aileron control) and yaw (rudder control) axes. Smooth flight requires coordinated control inputs to all these.

3. The airplane is trimmed for level flight at a given airspeed. With zero elevator deflection, adding throttle causes climb at that airspeed, retarding throttle causes descent at that airspeed. In full scale piloting we say we are “trimmed for airspeed.”

4. The term “lift” means the vertical component of the pressure force generated by the moving wing. See the diagram below. Note also the drag component.

5. Airplanes turn because of the sideways component of “lift” when we bank the wings. However banking also reduces the vertical component of “lift” and gravity will then cause the nose to drop. To maintain altitude in a turn, increase total “lift” with a bit of up elevator while banking….this increases angle of attack, which increases the components of “lift,” increases the rate of turn and keeps the airplane from descending. In full-scale piloting we say we “bank and yank” (roll into the turn, pull back on the stick). See the following diagram.
6. As a corollary to Item 5. realize that ANY TIME THE WINGS ARE NOT LEVEL THE AIRPLANE IS TURNING. Wings level is essential to straight flight...WORK ON IT. Otherwise your model will wander all over the sky and you will simply be chasing it, not guiding it.

7. Over the runway during landing, as the airplane slows and lift diminishes, use the elevator control to keep maintaining lift until even full “up” elevator won’t hold the airplane off any longer, then let touchdown occur on the main wheels with the tail low, as in the picture below.

Photo Credit: RealFlight

8. When the airplane is flying toward you, a good rule for keeping the wings level is to “push the aileron stick under the low wing.” This will return the wings to level and continue straight flight. Or, additionally, it will raise a wing to start a turn in the desired direction. A handy rule since directional control appears to be reversed when the airplane is flying toward you.

9. To center the airplane on the runway for landing, practice flying the final approach directly toward you until very near the runway edge, then turn GENTLY right or left to track the runway centerline. Gently means only maybe a 5 degree bank angle. You shouldn’t need much turn after a proper final approach. If you need more turn than this you’re probably misaligned, GO AROUND. Do NOT put surrounding people at risk with exaggerated maneuvers close to the flight line. Just go around and line up better next time.

10. A good landing is the result of a good stabilized approach with steady descent rate, proper speed and good alignment. Otherwise go around and try again.
11. Land with enough battery reserve to allow a couple of missed approaches and go-arounds.

12. Practicing good approaches is more important than practicing touchdowns, and easier on the airplane. Practice repeat approaches and go-arounds, learn what it takes to make a stabilized approach every time. At our CVRCC field, downwind altitude should appear twice as high as the background mountains, roll-out to final should appear to be over the palm trees (south) or the power line tower (north). For your repeat practice approaches I suggest flying over the dirt area just west of the runway rather than the runway itself...this allows room for the mistakes you will make! On the simulator, pick out some reference landmarks that will assure runway alignment from either direction and shoot to roll out over those every time.

13. At the flying field, generally fly “one mistake high” to preserve the model. That means high enough that a “full up elevator” emergency save maneuver after you get disoriented won’t cause the airplane to hit the ground. On the simulator you can fly lower to help keep the ground in view, but realize that’s only for the simulator.

14. A primary safety rule is “never point your airplane at people.” The final approach is somewhat pointed at our pilot stations but then we need to be spring-loaded to turn away. Remember that a turn away from the pilot line and pits is to the LEFT when approaching from the south, RIGHT from the north. Commit these to memory, practice on the sim. We’ve had numerous instances of pilots turning the wrong way and crashing into the fences, the pilot line, the pits or the shade covers. You won’t like the angry reaction if you do that, especially if you don’t yell “HEADS UP’ in time.

15. Do not let yourself become “a passenger in your own airplane” by not reacting to a bad situation. Keep your wits about you and take what you believe is the best corrective action. If that action is wrong, quickly reverse it. But DO SOMETHING, don’t just stand there paralyzed while your airplane does bad things.

16. Set up your transmitter in standard CVRCC format: aileron and elevator on the right stick, rudder and throttle on the left stick. Arrange all rate or condition switches to be operated by your left hand only so you do not have to take your right hand off the right stick to operate them. Program the rate and condition switches to be in the “up” or “forward” position at takeoff (i.e. low rates, flaps up, landing gear down, etc.). This will avoid confusion if you have to hand the transmitter to another pilot to help you out of trouble.

17. Use a neck strap or harness to hold your transmitter so you can use a two-finger grip (similar to holding a pencil) on the control sticks. Avoid using the “thumb on top of the stick” grip....it is simply not precise enough to avoid pulling-in unwanted cross-control, especially between the ailerons and elevator. A lot of unwanted airplane spiraling can be attributed to sloppy stick handling.

18. Utilize small and deliberate control stick movements to guide your airplane. The “student” mode on many trainer systems requires exaggerated stick movements to get the airplane to respond. Get away from this mode as quickly as you can. Accomplished pilots use small stick displacements to achieve most control, and this must be your goal. Your future more-sensitive airplanes will demand it.
19. Do not look away from your airplane while flying - it’s fatal. Do not look at your transmitter to find a control, you will lose sight of your airplane. Memorize the control switch locations and positions on your transmitter so you never need to look for them in flight.

20. Be ready to yell “Heads Up!” at the first sign of trouble, so others can take cover or help out, as appropriate. If necessary, dump the airplane into the dirt to avoid a close call with people.

21. A very good You Tube video to watch is “How to fly a 4 channel RC airplane” by VoroRC. He covers basic airplane handling very well. As you progress, watch his video “RC airplane basic aerobatic tutorial.”

22. For those of you with an Apprentice or Sensi training airplane, watch the VoroRC You Tube video “Beginner RC Plane: E-Flite Apprentice Flight Review.” You will see a good demonstration of the capabilities of these types of training planes. Note his admonition to get away from the artificial aspects of the “training” and “safe” modes quickly. Those modes might keep you from crashing but they do not prepare you for unrestricted flight, as all your later airplanes will require.
Flying Your Model

Overcontrol is a very common student problem and generates erratic flight. The trainer airplanes will fly “hands off,” and we need only apply small inputs to steer them around. Think “pressure” on the control stick more than “motion” to get the idea. Gentle pressure on the stick right or left along with light pressure toward up elevator will generate a smooth turn. Allow time for the airplane control surface to have an effect. For now, minimize down elevator inputs, they’re easily overdone.

Among most important skills to learn are:

A. Control of the airplane with small stick motions.
B. Directional control when flying toward you.
C. Level turns with constant gentle (30 deg. max) bank angle, no dropping off into a spiral.

All of these can be practiced on the simulator until the responses are automatic. You will quickly discover that you CANNOT control the airplane by mentally “putting yourself in the cockpit” and then making proper control inputs. Dismiss this idea immediately. Things happen too fast and at too many different view orientations for this to be successful.

Things to practice, both on the simulator and at the flying field:

a. Flying toward you, straight and level. Make horizontal figure-8’s, make the crossover point over some chosen ground reference point, make the circular parts with equal bank angles (30 deg. max) and equal radius, maintain constant altitude (see related Item c below). Repeat three times over the same ground reference point. The “flying toward you” part is ESPECIALLY IMPORTANT, wings level and flying straight, because it replicates what you must do on every landing approach.

b. The Emergency Save maneuver, full up elevator and low throttle. See how much vertical room this takes from inverted, that sets your “one mistake high” minimum altitude.

c. Level 180 and 360 degree turns, at constant bank angles. Learn the necessary elevator inputs to stay level at the steeper bank angles. More bank requires more up elevator to stay level. Some of your turns will fall off into a spiral because of overbanking. LEARN HOW TO RECOVER FROM THIS COMMON PROBLEM. See Items b. and e.

d. Turns over chosen ground reference points. Repeat them over these points. Put precision into your flying, rather than just chasing the airplane around the sky.

e. “Level the wings, level the nose” corrections to your deviations or excursions (those are polite terms to describe your screw-ups!).

f. Keeping the model close enough that you can clearly see it. IF YOU CAN’T SEE THE PLANE YOU CAN’T CONTROL IT. It’s that simple. We see numerous examples of the airplane getting too far away, then being turned the wrong direction and flying even farther away, and then being lost. No real excuse for this.

g. Stabilized approaches and go-arounds. Instead of landing, approach and then just fly straight down the runway centerline, level at about 10 ft high. Then climb upwind and fly the landing pattern again. Wonderful practice and builds confidence without the stress (and potential damage) of actually landing. Remember to call out “Low Approach” each time. A good landing REQUIRES a good approach, in models or full-scale.

h. Takeoffs with authority. Do not make wimpy takeoffs or go-arounds, get up to safe altitude rather quickly in case you lose power and have to make a dead-engine return to the field.
i. Dead-stick approaches. Traffic permitting, cut power to idle at some random point and learn what it takes to make a successful no-power approach to the field. Doesn’t have to be a full landing to teach you important things. Fly directly toward you until the field is assured, then maneuver for the landing. Don’t let the airspeed slow below gliding speed. Control the airplane all the way to the ground, don’t allow a stall, even if landing off-field. Advice from the great airshow pilot Bob Hoover, “fly the airplane as deep into the crash as possible.”

For RC pilots at all levels, the goal should be precise and deliberate flying to chosen sequences. This increases flying enjoyment, extends the life of our models and enhances the safety of everyone at the field. I strongly recommend watching the YouTube video “Becoming a Better Pilot: Flying Smooth” by James Winstead. It’s flying at a level beyond most of us but very inspirational. It sets out a philosophy that we should all use from the very beginning.

Safety at Home and at the Field

Safe operation of our equipment and our models is paramount. No one wants to suffer a personal injury or be responsible for injuring someone else. Safety is achieved by developing proper habits and maintaining an awareness (wariness would be a good word here) of what’s going on around you. Here are a few guides:

1. Use a spotter while flying. Keep your eyes on your own airplane, let the spotter keep his eyes on everything else. Be quick to yell “Heads up” or similar when you sense trouble.
2. Propeller accidents are always nasty. Operate in a way that fingers, hands and arms don’t contact a moving prop. Use lockout circuits on the electric airplanes and starting aids on the fuel airplanes.
3. Do not be alone at a flying site. Have another adult with you and have fully-charged cell phones. Misfortune happens quickly. You won’t be able to use your phone or drive your car if you’re bleeding heavily from an accident. Know the location of your flying site so you can inform first-responders. A first-aid kit should be in your car.
4. Study and practice safe handling procedures for lithium batteries. Keep them in fireproof bags or containers while storing, charging and transporting.
5. Gasoline, kerosene and model airplane fuel are volatile and flammable. Store, transfer and use these with proper equipment. Keep batteries and electrical equipment away from them.
6. Do not let your airplane be pointed at people during flight. Malfunction can occur at any moment and let your airplane fly into the crowd.
7. You are responsible for the safety of others when you are the pilot flying. Keep this in mind while you fly. Become a skilled and competent pilot....for the benefit of yourself and everyone around you.
Once you have mastered basic flying with your 4-channel training airplane you will want to do some of the basic aerobatic maneuvers. At first you will be happy to accomplish simple maneuvers during your random flying around. While this represents a step forward, please realize that true aerobatics incorporate a “presentation” aspect not found in random flying. As you learn the maneuvers, be thinking of how they appear to your audience and how to make them precise and deliberate,.the marks of a good pilot.

Very good demonstrations of elementary aerobatics can be seen in these You Tube videos by VoroRC: E-Flite Apprentice Flight Review and Basic RC Aerobatics. Also, as inspiration, watch again his video “Flying Smooth-Becoming a Better Pilot.”

To minimize the frustrations of crashing your model while you learn new maneuvers I highly recommend the use of a simulator. Hopefully you have already been using one to learn basic flying. Now choose a mildly maneuverable airplane like the Big Stick. Turn off any of the autopilot or safe flight features on these computer models, you will want direct control.

Your actual flying model airplane can be the Apprentice, the Timber or any of the many models intended for the Intermediate-Level pilot. A buddy box setup is desirable to allow a safety pilot to recover situations that go out of control. One of the airplanes that makes a good intermediate trainer is the E-Flite 1.1m T-28 Trojan, with its fixed tricycle landing gear. Any airplane that is reasonably maneuverable will do for initial training, but be aware that many of the self-righting features built into trainers actually get in the way of aerobatic maneuvering.

To make progress with aerobatics you must already be comfortable with basic flight with your chosen model so spend practice time learning that, including steep turns right and left. Practice flying level, back and forth parallel to your runway at about 30 feet high. Your flight track should be at least 25 feet in front of your pilot station.

Note that a comfortable viewing window for spectators (or later, competition judges) extends to about 60 degrees to the right or left of the viewers. We will define this later as the “aerobatic box” in which you will display your maneuvers.

On your simulator, position your airplane at enough distance that you can see almost all of the vertical portions of the maneuvers with the ground in view. This will allow you to make use of ground reference points to define your aerobatic box and set the start, end and crossover points for your maneuvers. A sample simulator screenshot is shown below. Some of the available computer airplanes have a smoke feature. Use it sparingly to define the exact flight path you are creating and to highlight errors. The model shown is the Decathalon, a good mid-level aerobatic airplane.
Many aerobatic maneuvers are simply combinations of loops, rolls and inverted flight. They are described in the videos previously mentioned. Not emphasized much in most videos are these points:

1. An important but little-recognized benefit of learning aerobatics is that it makes us safer pilots. A pilot who can control his airplane through numerous attitudes and orientations is much less risk to everyone else around him than the pilot who cannot.

2. With your actual model, do your flying at least “one mistake high.” That is, high enough that if in a dive you can pull full up elevator and not hit the ground. With your simulator you can fly lower to keep the ground in view.

3. Accomplished aerobatics are not part of “random flying around.” They are deliberate maneuvers with specific placement, size, shape, speed, track and direction. They are placed within comfortable view of the pilot, spectator or judge. Multiples (say three loops) will overlay each other exactly. Entry and exit will be level flight at exactly the same altitude. No randomness or variation is permitted. Everything is smooth and deliberate. Your initial attempts will not be that way but your goal must be deliberate precision and will be the gauge of your progress.

4. The aircraft’s flight for the two seconds before and after the aerobatic maneuver is considered part of the maneuver. These two second intervals should be of dead-level straight flight, no wiggles or wobbles. Note that when doing a sequence of maneuvers, say a loop followed by a roll, that the exit of the first maneuver is essentially the entry to the second one, so the exit really needs to be dead straight and accurately placed.

5. The most common reason for the airplane not tracking accurately through a maneuver is that the wings are not level (i.e. horizontal) on entry, nor corrections made at
opportune points midway through the maneuver. **Recognize that any time the wings are not level the airplane is turning.** “Wings level” must be your thought on entering maneuvers to keep them straight. For example the simple inside loop: If wings are not level on entry pullup, the airplane will spiral right or left. A good time for mid-point correction is at the top of the loop. Adjust for wings level as the airplane goes over the top to prevent spiral tracking during the downward half of the loop. Then on exit make sure the wings are level and the airplane is exiting at exactly the same spot and altitude where the loop started, and in perfect horizontal flight, ready for the next maneuver. The judging criteria applied to the inside loop and several other basic maneuvers are depicted below. Diagrams and criteria are from the 2017 International Model Aerobatics Club Judge’s Training Guide.
6. You must master inverted flight. It needs to become almost as easy as upright flight. Sustained inverted flight requires continuous slight “down” elevator input (sometimes referred to as “top elevator” by aerobatic pilots). Practice on your simulator and at the field. Stay at least one mistake high with your actual model, but spend at least 30% of each flight with the airplane inverted. Learn the commands necessary to fly straight toward you while inverted and then turn safely away. Skill at inverted flight will become one of your most important capabilities and will take away much “ground-shyness.”

7. Manoeuvres are not mastered until they can be done at an appropriate speed. Use full power on the uplines, reduce power on the downlines, thereby keeping the speed approximately constant throughout the maneuver. Throttle management is an important skill to learn, for all your flying.

8. You will quickly discover that a sequence of maneuvers is much harder to perform than a single maneuver. It is of great benefit to learn to do sequences. Establish a simple sequence for yourself, like two loops followed by a roll followed by a level 180 degree turn for course reversal. Practice making this sequence look really good, with a nice entry, nice exit and no erratic portions. On your simulator, the setup for practice should put the airplane in an “aerobatic box” parallel to the runway and far enough away to keep the ground in view yet close enough to see the airplane orientation. Use binocular view to help see the plane when it gets a little distant.

9. Once you have at least partially mastered your initial practice sequence, move to a more demanding one. This sequence is seven maneuvers, starting level and into the wind. Work on keeping it within a reasonable “aerobatic box” for nice display.

1) Loop (upwind)
2) Humpty Bump, ½ roll on vertical downline (course reversal)
3) Reverse Shark Tooth, ½ roll on 45 degree upline (course reversal)
4) Aileron Roll (upwind)
5) Hammerhead / Stall Turn (course reversal)
6) 360 degree Aerobatic Turn (downwind)
7) Immelmann, ½ roll on top (course reversal)

The loop was described previously. The other descriptions follow. The diagrams all presume the wind is from the right, but of course your actual maneuvers will involve course reversal between upwind and downwind. Remember to apply top elevator to the inverted portions of the maneuvers, including the brief inverted portion of the full roll.
Humpty bump

Judging Criteria:
- Figure must be wind corrected.
- Entry and exit radii may be different with no deduction.
- Length of vertical up-line and vertical down-line may be different; entry and exit altitude may be different.
- Top 1/2 loop must be “pull” (inside) and may be different from the entry and exit radii.
- 1/4 Aileron roll must be centered on vertical down-line.
- 1/8 Point deduction per 5 degrees deviation from wings-level, track, vertical up-line, vertical down-line, horizontal entry & horizontal exit.
- Must be a distinct horizontal line between figures 6 and 7. Deduction of 1 point from each figure for omitted line.

Reverse Shark’s Tooth

Judging Criteria:
- Part loop radii do not have to be equal.
- All lines and part loops must be wind corrected.
- Entry and exit altitudes may be different.
- 1/2 Roll on 45 degree up-line must be centered and can be in either direction. The roll rate must be constant. 1 point deduction for each roll rate change.
- Must have a line before and after half roll.
- 1/8 Point deduction per 5 degrees deviation from wings-level, track, vertical up-line, 45 degree down-line, horizontal entry & horizontal exit.
- Must be a distinct horizontal line between figures 3 and 4. 1 point deduction from each figure for omitted line.
Judging Criteria:
- Figure must be wind corrected.
- Full roll must be of a constant rate; pilot's choice of direction.
- 1 Point deduction for each roll rate change.
- Aircraft track must remain horizontal before and during roll.
- 1/2 Point deduction per 5 degrees deviation from wings-level, track, horizontal entry, & horizontal exit.
- Must have a distinct horizontal line between figures 4 and 5. 1 Point deduction from each figure for omitted line.

6.2 SCA-17
Judging begins once a horizontal flight path of one fuselage length is established following the exit of the previous figure.

Hammerhead (Stall Turn)

Judging Criteria:
- Figure must be wind corrected except for the pivot (stalked portion).
- Entry and exit altitude may be different.
- Entry and exit radii may be different.
- up-line and down-line may be different lengths.
- Pivot in either direction.
- As the aircraft nears the point where it would stop climbing, it must pivot in a vertical plane (pitch axis). Deduction of 1/4 point per five degrees for not pivoting in a vertical plane.
- There must be no rotation around the pitch or roll axis.
- 1/2 Point deduction per 5 degrees deviation from wings-level, track, vertical up-line, vertical down-line, horizontal entry & horizontal exit.
- 1/2 Point deduction per 5 degrees of pendulum after the hammer.
- Any visible downward slide before the pivot starts will zero the maneuver.
- Must be a distinct horizontal line between figures 2 and 3. 1 Point deduction from each figure for omitted line.

6.3 SCA-17
The figure is complete at the moment the aircraft returns to a wings-level, horizontal flight path of one fuselage plane length. Judging for next figure begins.
**360° Turn**

**Judging Criteria:**
- Sequence begins when the aircraft departs from wings-level horizontal flight.
- Turn begins and ends on a wings-level horizontal line.
- Bank angle must be between 60° - 90°. Any less or more is a deduction of ¼ point per 5 degrees.
- Entry and exit roll rate must be the same. 1 point deduction if different.
- Once established, the bank angle must remain constant; any deviation is a deduction of ¼ point per 5 degrees.
- Turn must have constant radius throughout (must be wind corrected). Any variation in turn radius is a 1 point deduction per occurrence.
- ½ Point deduction per 5 degrees deviation from wings-level, track, horizontal entry & horizontal exit.
- Must be a distinct horizontal line between figures 1 and 2. 1 Point deduction from each figure for omitted line.

---

**Immelmann (Half inside loop with half roll exit)**

**Judging Criteria:**
- Figure must be wind corrected.
- ½ Roll must be of a constant rate (pilot's choice of direction) and completed immediately after ½ inside loop. 1 point deduction for each roll rate change.
- Drawing a line between ½ loop and ½ roll is a minimum downgrade of 2 points.
- Aircraft starting ½ roll prior to completing the ½ loop radius (wings-level horizontal) is a downgrade of ¼ point per 5 degrees of remaining loop radius.
- ½ Loop must be constant radius of pilot's choice – must appear round to judges.
- Any variation in radius is a 1 point deduction per occurrence.
- Any flat spot is a 1 point deduction per occurrence.
- ½ Point deduction per 5 degrees deviation from wings-level, track, horizontal entry & horizontal exit.
- Must be a distinct horizontal line between figures 9 and 10. Deduction of 1 point from each figure for omitted line.
10. It is often helpful to practice new maneuvers or sequences in slow motion so you can see exactly what is happening. On the simulator go to Physics and set the speed at 80%. (On Real Flight 6.5 the commands are Simulation > Physics > Custom > Physics Speed > 80%). To choose an in-flight beginning for a repeat scenario, press the P key as the model is at the desired beginning point, then the Reset button will take you there each time.

11. As you progress you’ll want more capable airplanes to fly. A good general rule is to get an airplane with a little more capability than you have as a pilot, and then grow into that airplane until you can exploit it fully. Choose these airplanes by observing what other pilots are flying at the field, not by what’s written in the advertising. Have an experienced pilot trim out the new plane for you and set it up with control throws and exponentials that are comfortable for you.

12. Once your proficiency level improves you can move to an IMAC-recognized sequence of maneuvers. The “Basic” program for 2017 is shown below for your reference. An in-flight demonstration of these maneuvers is presented in the YouTube video “IMAC BASIC 2017” by AeroDicas. Full information about IMAC can be found at www.miniac.org, including tutorials.